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Takk for at du kjøpte MagBinder® Fit24 nukleinsyre-rensesystem.

For riktig bruk av instrumentet må du lese denne håndboken nøye før bruk 
og ta vare på den for fremtidig bruk.

Inspeksjon ved åpning

Kontroller instrumentet når du åpner pakningen for første gang. Hvis du finner 
noe som mangler eller er feil, kan du kontakte oss på info@omegabiotek.com.

Omega Bio-tek
400 Pinnacle Way, Suite 450
Norcross, GA 30071
Telefon: +1-770-931-8400
E-post: info@omegabiotek.com
Nettsted: www.omegabiotek.com

Forord 

Forord 
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Utstyrsinnhold

Utstyrsinnhold

Element Antall
Hovedenhet 1

EU-strømledning 1

UK-strømledning 1

Brett 1

Brettstøtter 2

Mus 1

Unbrakonøkkel, 2,5 mm 1

Unbrakonøkkel, 3,0 mm 1

USB 1

Kvalifikasjonssett1 1

1MagBinder® Fit24-kvalifikasjonssettet er inkludert med kjøpt utstyr, men 
settet leveres separat.
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Sikkerhetsadvarsler og retningslinjer

Sikkerhetsadvarsler og retningslinjer

1.	 Generell sikkerhet

Les hele denne brukerhåndboken nøye før bruk.

Les denne brukerhåndboken nøye før du bruker instrumentet. 
Hvis du ikke leser, forstår og følger instruksjonene i håndboken, 
kan det føre til skade på instrumentet, potensiell skade på 
operatøren eller redusert instrumentytelse.

Forsiktig: tung. Bruk løfteteknikker med to personer for å flytte 
utstyret.

2.	 Sikkerhetstips

Bruken, vedlikeholdet og reparasjonen av instrumentet skal være i samsvar 
med de grunnleggende retningslinjene og forholdsreglene oppført nedenfor. 
Vær spesielt oppmerksom på alle «Advarsel»-, «Forsiktig»-, «Merk»-utsagn 
samt sikkerhetssymboler og -merker som finnes på instrumentet og i denne 
håndboken. Feil bruk av instrumentet kan forårsake skade på systemet, 
unøyaktige resultater og/eller potensielt ugyldiggjøre garantier.

Dette instrumentet er et benkeinstrument som samsvarer med 
klasse I i IEC 61010-1-standarden og IEC 61326-standarden.

For å minimere risikoen for personskade, biologisk farlig 
kontaminasjon, brann eller elektrisk støt må du alltid følge 
grunnleggende sikkerhetstiltak og lokale sikkerhetsprotokoller 
når du bruker dette instrumentet.

Operatøren skal ikke åpne eller reparere instrumentet uten 
tillatelse fra selskapet. Manglende overholdelse kan medføre 
potensielle skader på instrumentet og personellskader samt 
påvirke garantien.

Før du slår på instrumentet, må du sørge for at spenningen 
samsvarer med instrumentets krav og at den maksimale 
nominelle lasten kan gi støtte instrumentet tilstrekkelig. Hvis 
strømledningen er skadet, må den erstattes med en ledning 
som samsvarer med de samme spesifikasjonene. 
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Sørg for at strømledningen forblir lett tilgjengelig og at den 
er plassert unna områder med mye trafikk under bruk. Når du 
kobler støpselet fra stikkontakten, må du passe på å gripe godt 
tak i støpselet og unngå å dra i selve strømledningen.

Varmeblokkens overflater kan nå høye temperaturer under 
drift. For å unngå potensiell skade må du ikke berøre disse 
overflatene når instrumentet er i bruk.

Hold instrumentet fritt for støv, vann, direkte sollys eller 
sterk lyskilde, varmekilder, korroderende gasser og sterke 
magnetiske forstyrrelser. Sørg for riktig ventilasjon med lave 
luftfuktighetsnivåer. Hvis det brukes flere instrumenter, må 
det opprettholdes en separasjonsavstand på 10 cm eller mer 
mellom dem.

For å sikre instrumentets optimale pålitelighet er det viktig å 
følge instruksjonene for forebyggende vedlikehold nøye. Et 
instrument som ikke er godt vedlikeholdt, vil kanskje ikke gi 
optimale resultater.

Sørg for å slå av instrumentet etter bruk. Hvis instrumentet ikke 
skal brukes på lang tid, skal det kobles fra stikkontakten. Dekk 
til instrumentet for å unngå ansamling av støv.

Frakoble instrumentet umiddelbart i følgende situasjoner og 
kontakt leverandøren:
•	 Det lekker væske inn i instrumentet
•	 Instrumentet blir vått eller blir svidd/brent
•	 Instrumentet fungerer ikke som normalt, f.eks. unormal lyd 

eller lukt
•	 Instrumentet har falt ned og/eller det ytre dekselet er 

skadet
•	 Instrumentet har sviktet

Sikkerhetsadvarsler og retningslinjer
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Dette instrumentet inneholder permanente magneter. 
Operatører med pacemaker eller metallproteser skal ikke bruke 
dette instrumentet. Nær kontakt med et magnetfelt kan skade 
eller påvirke pacemakeren eller protesen.

Unngå å plassere MagBinder® Fit24 i nærheten av magnetbånd, 
datamedier eller andre magnetiske lagringsenheter, da 
magnetfeltet som genereres av instrumentstengene, potensielt 
kan forårsake skade på dem. Vær forsiktig for å unngå utilsiktet 
skade på magnetene under rengjøringsprosessen.

MagBinder® Fit24 er utstyrt med en UV-lampe for 
dekontaminering av prosesskammeret. Vær oppmerksom på  
at UV-lampen deaktiveres automatisk når frontluken åpnes.

Indikerer instruksjoner for kassering.
IKKE kast dette instrumentet i usortert kommunalt avfall  
når instrumentets levetid er utløpt. Følg lokale forskrifter  
for avfallshåndtering for riktig kassering.

Sikkerhetsadvarsler og retningslinjer
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Sikkerhetsadvarsler og retningslinjer

3.	 Forebyggende vedlikehold

For å sikre konsekvent daglig ytelse må instrumentets miljø holdes fritt 
for støv og væskesøl. Unngå bruk av skurende rengjøringsmidler, da de 
kan forårsake skade på instrumentet. 

Rengjør om nødvendig de utvendige overflatene eller dekslene 
på instrumentet med en klut fuktet med vann eller et mildt 
rengjøringsmiddel. Rengjør magnetstengene med en myk klut eller 
engangsserviett gjennomfuktet med en mild rengjøringsløsning,  
en såpeløsning eller alkohol når det trengs. Følg produsentens 
anbefalinger for fortynning av rengjøringsmidlet.

Fjern straks utsølte saltvannsoppløsninger, løsemidler, syrer eller 
alkaliske løsninger fra utvendige overflater. Langvarig eksponering 
for disse oppløsningene kan forårsake skade. Hvis noen overflater blir 
kontaminert med biologisk farlig materiale, skal det påføres en mild 
dekontamineringsoppløsning, som nevnt tidligere, på det berørte 
området.

Ikke bruk noe rengjøringsmiddel som inneholder blekemiddel, da det 
kan reagere med guanidinbaserte kaotrope agenser og danne en svært 
reaktiv forbindelse.
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4.	 Retningslinjer for transport og oppbevaring

Omgivelsestemperatur: 10–35 °C
Relativ fuktighet: ≤ 70 %
Atmosfærisk område: 500–1060 hPa
Godt ventilert område uten eksponering for korroderende gass

5.	 Garanti og service

5.1	 Innhold

Omega Bio-tek vil erstatte instrumentet i tilfelle mangler i materialer og 
utførelse som oppdages innen én måned etter leveringsdato. Garantiperioden 
er 12 måneder fra leveringsdato for eventuelle instrumentfeil som skyldes 
mangler i materialer og utførelse. I løpet av denne garantiperioden vil Omega 
Bio-tek enten reparere eller erstatte instrumentet hvis det viser seg å være 
defekt, avhengig av hvor alvorlig problemet er.

Brukeren vil sende produkter under garanti til vedlikeholdsavdelingen utpekt 
av Omega Bio-tek. Brukeren betaler for frakten av instrumentet til selskapet, 
og selskapet betaler for returforsendelsen.

Kontakt info@omegabiotek.com for informasjon om utvidede garantier  
og/eller tjenester. 

5.2	 Dekning

Garantien ovenfor gjelder ikke for skader forårsaket av feil bruk og 
vedlikehold utført av brukeren, ikke-samsvarende bruksmetoder utført av 
brukeren, uautorisert vedlikehold og/eller modifikasjon av instrumentet.

Sikkerhetsadvarsler og retningslinjer
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Kapittel 1 Innledning

Kapittel 1 Innledning

MagBinder® Fit24 Nucleic Acid Purification System bruker magnetstenger 
unisont til å adsorbere, overføre og frigjøre magnetiske partikler i 
reagenspatronbrønnene for rensing av DNA og RNA. Instrumentet 
har plass til 1 til 24 prøver samtidig ved bruk av magnetperlebaserte 
nukleinsyreekstraksjonssett, fra en rekke prøvetyper.

1.1	 Tiltenkt bruk

MagBinder® Fit24 er et magnetperlebasert prosesseringsinstrument beregnet 
på automatisering av laboratoriearbeidsflyter, inkludert rensing av nukleinsyre 
for etterfølgende in vitro-diagnostisk bruk.

MagBinder® Fit24 er beregnet på profesjonell bruk i et laboratoriemiljø. 

MagBinder® Fit24 leveres med forhåndslastede protokoller designet for 
å fungere med Omega Bio-tek-sett. Se spesifikke sett for instruksjoner 
om hvordan du kjører de forhåndslastede protokollene. Ta kontakt med 
Omega Bio-tek på info@omegabiotek.com hvis du har spørsmål om 
instrumentprotokoller.  

Vær oppmerksom på at brukeren er ansvarlig for å verifisere 
ytelsesegenskapene for en prosedyre som ikke dekkes av Omega Bio-tek 
sine evalueringsstudier av ytelsen. Brukeren er også ansvarlig for å etablere 
ytelsesmålinger som er nødvendige for det valgte diagnostiske bruksområdet 
nedstrøms.

1.2	 Produksjonsgaranti

Produsentens garanti for instrumentet er 12 måneder fra forsendelsesdato.

Kontakt info@omegabiotek.com for informasjon om utvidede garantier  
og/eller tjenester.
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1.3	 Funksjoner

•	 Brukervennlig grensesnitt på berøringsskjerm
•	 3 hurtigtaster og/eller musebetjening
•	 Varmefunksjon tilgjengelig
•	 UV-lys for dekontaminering av instrumentet
•	 Stille drift med minimal vibrasjon
•	 Minimalt med interaksjon når prøver analyseres på instrumentet

Kapittel 1 Innledning
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2.1	 Normale driftsretningslinjer

Miljøtemperatur: 10–35 °C
Relativ fuktighet: ≤ 70 %
Inngang: Vekselstrøm 100–240 V, 50 Hz/60 Hz

2.2	 Grunnleggende parametere og ytelse

Tabell 1 Grunnleggende parametere og ytelse

Parameter Modell: MagBinder® Fit24

Prinsipp Magnetperlebasert prosessering

Kapasitet 1–24 prøver

Plastartikler 5 ml eller 10 ml reagenspatroner + 2 ml elueringsrør

Prøvevolum (μl) 50–10 000 μl

Varmeblokk Omgivelsestemperatur til 100 °C

Temperaturnøyaktighet ±1 °C

Elektrisk sikkerhet

Samsvarer med følgende krav:
NO IEC 61326-1
NO IEC 61326-2-6
NO IEC 61010-1
NO IEC 61010-2-101

Driftsgrensesnitt 7 tommer berøringsskjerm, 3 hurtigtaster og mus er  
tilgjengelig

Internminne Opptil 8 protokoller på snarveiskjermbildet med mulighet 
til å lagre opptil 100 protokoller

Protokollimport Standard USB

Protokollstyring Mulighet til å opprette nye, redigere, slette og/eller lagre 
protokoller

Dekontaminering UV-lys

Avtrekk Intern vifte

Maks inngangseffekt 450 W

Dimensjon (B x D x H) 400 mm × 530 mm × 480 mm

Vekt (kg) 34 kg

Kapittel 2 Spesifikasjoner

Kapittel 2 Spesifikasjoner
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2.3	 Totale dimensjoner

Avsnitt 2 Spesifikasjoner

Dimensjon (B x D x H)

MagBinder® Fit24: 400 mm x 530 mm x 480 mm

D

H

B
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Dette avsnittet dekker den skjematiske instrumentoversikten og plasseringen 
av kun kritiske instrumentfunksjoner.

3.1	 Struktur

3.1.1	 Forside

3.1.2	 Bakside

Avsnitt 3 Skjematisk produktoversikt

 
Socket 
 

Fuse 

Power Switch 
 

Fan 

Skjerm

Hurtigtast

Driftsvindu

USB-port

Ethernet-port

PC-port

Vifte

Strømbryter

Sikring

Kontakt

Kapittel 3 Skjematisk produktoversikt
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3.1.3	 MagBinder® Fit24 på innsiden

3.2	 Driftspanel

Displayskjerm: Berøringsskjermbetjent eller koble mus til USB-porten foran

TAB (Tabulator): For valg av snarveiprotokoll

RUN (Kjør): Velg for å starte snarveiprotokoll

STOP (Stopp): Avbryt driftsfunksjoner

Kapittel 3 Skjematisk produktoversikt

Magnetisk arm
(over spisskamholder)

Monteringsspor for 
spisskam Varmeblokk

Plate

UV-lampe (øverst 
på innsiden)

Vifte (nederst på 
innsiden)

Displayskjerm

TAB (Tabulator)

RUN (Kjør)

STOP (Stopp)
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Kapittel 4 Installasjon

4.1	 Før du pakker ut instrumentet

MagBinder® Fit24 må installeres på en stabil, jevn overflate som kan romme 
vekten (34 kg) og de totale dimensjonene (400 mm x 530 mm x 480 mm)  
til instrumentet. Sørg for at det utpekte arbeidsområdet er rent, ryddig og 
fritt for hindringer som kan forstyrre driften av instrumentet.

Verktøy leveres med instrumentet for å frigjøre luken, skyveplaten og de 
magnetiske armene før instrumentet slås på. Kontroller og bekreft riktig 
spenning på instrumentet før du kobler til. Instrumentet må kobles til en 
dedikert elektrisk krets som kan levere 100–240 V vekselstrøm, 50/60 Hz  
med minst 5 A.

Installasjonsstedet skal være godt ventilert for å sikre tilstrekkelig 
luftsirkulasjon rundt instrumentet. Sørg for at temperaturen og fuktigheten på 
installasjonsstedet er innenfor de anbefalte områdene: omgivelsestemperatur 
mellom 10 °C til 35 °C og relativ fuktighet på ≤ 70 %. Omgivelsestemperaturen 
på installasjonsstedet må holdes mellom 10 °C og 35 °C (50 °F og 95 °F) 
for å sikre optimal ytelse av instrumentet. Den relative fuktigheten på 
installasjonsstedet skal holdes ved ≤ 70 %. Bruk om nødvendig en  
temperatur- og fuktighetssensor til å overvåke disse forholdene.

Kapittel 4 Installasjon
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Kapittel 4 Installasjon

4.2	 Utpakking av instrumentet

Ta instrumentet forsiktig ut av emballasjen og plasser det på en stabil, jevn 
overflate. MagBinder® Fit24 veier ca. 34 kg, og det anbefales at to personer 
løfter instrumentet sammen. Sørg for at alle komponenter er til stede  
(se «Utstyrsinnhold» på side ii). Fjern teipen som holder luken lukket. Åpne 
instrumentluket og fjern skummet for å skyve platen ut (figur 1). Bruk den 
medfølgende 3 mm sekskantnøkkelen til å fjerne skruene, og ta ut den 
røde støtten som er skrudd inn i platen (se rød pil, figur 2) for å frigjøre den 
magnetiske armen.

Merk: Vær forsiktig ved utpakking for å unngå å skade magnetstengene.

Figur 1

Figur 2
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4.3	 Plassere brettstøttene

Skyv ut platen og plasser brettstøttene som vist i figur 3. Plasser støtten 
nummerert  på venstre side og støtten nummerert  på høyre side av 
platen.

Kapittel 4 Installasjon

4.4	 Koble til strøm

Koble den ene enden av strømledningen til instrumentkontakten og den 
andre til stikkontakten (vekselstrøm 100~240 V). Slå på strømbryteren bakpå 
instrumentet.

4.5	 Kjøre MagBinder® Fit24-kvalifikasjonssettet

MagBinder® Fit24-kvalifikasjonssettet (leveres separat) brukes for å sikre at 
instrumentet fungerer som det skal. Åpne settet og følg anvisningene som  
er angitt i protokollen.

Figur 3

Plate
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Kapittel 4 Installasjon

4.6	 Klargjøre reagensene

Plasser reagenspatronene og elueringsrørene i brettet på de tilsvarende 
posisjonene (figur 4). Sørg for at elueringsrørene er plassert åpne med 
lokkene orientert til høyre for røret og trykket ned som vist i figur 4.  
Åpne luken, skyv ut platen og plasser brettet på platen. Trykk patronene  
og elueringsrørene godt ned for å sikre at de sitter godt i varmeblokken  
på platen (figur 5). Skyv platen langsomt tilbake inn i instrumentet.

Figur 5

Figur 4

Elueringsrør Elueringsrør

Brett
Reagenspatron

Brett

Brettstøtte
Plate
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4.7	 Innsetting/fjerning av spisskammer

Sett inn spisskammen ved å skyve den helt inn i monteringssporene  
på toppen av den magnetiske armen. Skyv spisskammen helt bak slik  
at den festes forsvarlig (se røde piler, figur 6).

Fjern spisskammene ved å trekke dem ut av monteringssporet.  
Kast spisskammene i riktig avfallsbeholder.

Kapittel 4 Installasjon

Figur 6

Monteringsspor

Spisskam
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5.1	 Oppstartsgrensesnitt

Sørg for at luken er lukket før du starter. Slå på instrumentet for å vise 
oppstartgrensesnittet.

Kapittel 5 Drift

Kapittel 5 Drift

Når instrumentet er klart, bytter displayet til snarveiskjermbildet vist 
nedenfor.
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Kapittel 5 Drift

5.2	 Kjøre et program

5.2.1   Snarvei

På snarveiskjermbildet (avbildet på forrige side) velger du ønsket 
program og trykker på «Run» (Kjør) på høyre side. Dette tar deg til 
grensesnittet for kjøring av program.

Programmet kan også velges ved å trykke på «Tab» (Tabulator)-
knappen på panelet, og deretter trykke på «Run» (Kjør) for å starte 
eller på «Stop» (Stopp) for å avbryte.

I figuren ovenfor vises informasjon om gjeldende protokolltrinn på 
venstre side av skjermen. Den markerte brønnen indikerer gjeldende 
posisjon i programmet. 

Posisjonen og temperaturen til varmeblokken vises også på 
skjermen. 

Nederst i skjermbildet vises fremdriftslinjen. Gjenværende tid for 
programmet vises øverst til høyre.
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Kapittel 5 Drift

5.2.2   Stoppe et program eller sette det på pause

For å stoppe et program velger du «Stop» (Stopp) under kjøringen. 
Velg «Cancel» (Avbryt) for at programmet skal fortsette å kjøre. 
Velg «Confirm» (Bekreft), så stopper programmet, og brukeren tas 
tilbake til startskjermbildet. For å starte det samme programmet på 
nytt etter stopp velger du «Rerun» (Kjør på nytt), og programmet 
gjenopptas fra begynnelsen.

For å sette et program på pause midt i kjøringen velger du «Pause» 
(Pause) under kjøringen. For å gjenoppta programmet velger du 
«Continue» (Fortsett).

Velg «Back» (Tilbake) for å gå tilbake til forrige skjermbilde.

Viktig: Hvis luken er åpen under kjøring, vises meldingen nedenfor 
på skjermen. Når luken er lukket, fortsetter instrumentet å kjøre.
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Kapittel 5 Drift

5.2.3   Listemodus

Brukeren kan se alle programmene ved hjelp av rullefeltet på høyre 
side. Velg ønsket program på listen. Trykk på «Run» (Kjør) for å gå til 
hovedskjermbildet og starte programmet. 

Velg «View» (Vis) for å se programtrinnene og parametrene. I dette 
skjermbildet velger du «Option» (Alternativ) i et avsnittstrinn for å 
vise parametrene for hvert trinn. Ingen endringer kan gjøres i dette 
skjermbildet.

Velg «Back» (Tilbake) for å gå tilbake til forrige skjermbilde.
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5.2.4   Lampe

Nederst til høyre på skjermen indikerer ikonet «       » at lampen er 
på. Ikonet «       » indikerer at lampen er av. Velg dette ikonet for å slå 
instrumentlampen av eller på.

5.3	 Programadministrasjon

Velg «Manage Prog.» (Administrer program) for å åpne skjermbildet for 
programadministrasjon.

5.3.1   Snarvei

Velg «» i kolonnen Shortcut (Snarvei) for å vise protokollen i 
menyen Shortcut (Snarvei). 

En protokoll med låst-ikonet «       » betyr at den ikke kan redigeres, 
slettes eller lagres. Ingen endringer kan utføres. En protokoll med 
låst opp-ikonet «       » betyr at protokollen kan redigeres, slettes eller 
lagres.
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5.3.2   Opprette en ny protokoll

Velg «New - 5 mL» (Ny - 5 ml) eller «New - 10 mL» (Ny - 10 ml) på 
høyre side av skjermbildet Manage Prog. (Administrer program) for 
å opprette en ny protokoll basert på reagenspatronens størrelse. 
Opprett et navn for den nye protokollen, og trykk på «Enter» (Angi).

Velg «Insert» (Sett inn) for å legge til et nytt trinn i protokollen.

Velg «         » på høyre side for å vise flere parameterinnstillinger.
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Velg «          » for å gå tilbake til parametrene i forrige skjermbilde.

Hver parameter og dens funksjon vises i tabellen nedenfor. Merk at 
noen parametere er deaktivert avhengig av trinnets betingelser.

Trinnparametere og funksjon
Parameter Beskrivelse Funksjon Merknader

Well (Brønn)

Brønnummer 
eller posisjon for 
reagenspatronen.

Posisjon der trinnet 
begynner i protokollen.  

Visse alternativer er 
deaktivert avhengig av 
valgt brønnposisjon.

Sett inn Pause 
for å muliggjøre 
brukerinteraksjon 
med instrumentet 
under kjøring.

Angi «0» eller «9» for å 
legge til et pausetrinn i 
protokollen. 

Magnetstangen vil være 
over reagenspatronen. 
Alle andre alternativer er 
deaktivert.

Angi «0» for å pausere 
med magnetstangen 
utenfor spisskammen.

Angi «9» for å pausere 
med magnetstangen 
innenfor spisskammen.

Name (Navn) Navn på trinnet
Trinnavnet vises i en 
popup-melding under 
protokollkjøring

Navnet må være ≤ 9 
tegn.

Mix Time 
(min) 
(Blandetid 
(min))

Hvor lenge det skal 
blandes

Tiden det tar å blande den 
valgte brønnen

Angi verdier mellom  
0,0 og 99,0.

Magnet (sec) 
(Magnet 
(sek))

Hvor lenge det skal 
magnetiseres

Tiden det tar å magnetisere 
de magnetiske partiklene

Angi verdier mellom  
0 og 999.
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Wait Time 
(min) 
(Ventetid 
(min))

Hvor lenge  
instrumentet skal 
vente etter partik-
keloppsamling

Ventetiden før neste trinn 
startes

Angi verdier mellom  
0,0 og 99,0.

Volume (µL) 
(Volum (μl))

Totalt volum i rea-
genspatronbrønn

Totalt volum brukes til å 
bestemme alternativene Mix 
Pos (Blandeposisjon), Mix 
Amp (Blandeamplitude) og 
Mag Pos (Magnetposisjon).

Instrumentet vil som 
standard ha maks. volum 
hvis innlagt volum er 
for høyt for den valgte 
brønnposisjonen.

10 ml strimmel: Maks. 
volum for første brønn, 
10000 μl. Alle andre 
brønner opptil 1000 μl.

5 ml strimmel: Maks. 
volum for første brønn, 
5000 μl. Alle andre 
brønner opptil 1000 μl.

Mix Speed 
(1-10)  
(Blandehas-
tighet (1–10))

Hastighet på 
blandingen

Angi «1» for tregest 
hastighet og «10» for raskest 
hastighet.

Blandetiden må være  
≥ 1 minutt

Temp (°C) 
(Temperatur 
(°C))

Varmeblokkens 
temperatur

Innstilt temperatur for de 4 
varmeblokkene på platen. 

Angi < 37 °C for ikke å 
varme opp under trinnet. 
Angi > 37 °C for å varme 
opp til innstilt temperatur.

Gjelder kun i følgende 
situasjoner:

10 ml reagenspatron: 
brønnposisjon 1 og 6.

5 ml reagenspatron: 
brønnposisjon 1 og 8.

Mix Pos  
(0-100%) 
(Blande-
posisjon 
(0–100 %))

Magnetstangpo-
sisjon i brønn for 
blandingstrinn

Instrumentet beregner 
posisjonen i brønnen i 
henhold til brønnens totale 
volum.

Angi «0» for 
brønnbunnen 
eller «100» for 
væskeoverflaten. 
Blandetiden må være  
≥ 1 minutt.

Mix Amp  
(0-100%) 
(Blande-
amplitude 
(0–100 %))

Magnetstangens 
høydeposisjon 
under 
blandingstrinnet

Instrumentet beregner 
posisjonen i brønnen i 
henhold til brønnens totale 
volum.

Angi «0» for minste 
eller «100» for 
største amplitude for 
magnetstangen.

Dette alternativet 
er deaktivert i 
brønnposisjon 1.

Mag Pos  
(0-100%) 
(Magnet-
posisjon 
(0–100 %))

Plasseringen til 
magnetstangen i 
brønnen

Instrumentet beregner 
posisjonen i brønnen i 
henhold til brønnens totale 
volum.

Magnettiden må være  
≥ 1 sekund.

Mag Speed 
(1-10)  
(Magnethas-
tighet (1–10))

Magnetiserings-
hastighet under 
partikkeloppsam-
ling

Angi «1» for tregest 
hastighet og «10» for raskest 
hastighet.

Magnettiden må være  
≥ 1 sekund.

Kapittel 5 Drift
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Velg «Option» (Alternativ) for å gå til et nytt skjermbilde hvor 
brukeren kan definere et annet sett med parametere for det 
gjeldende trinnet som er valgt. Følgende tabell beskriver 
parametrene og funksjonene i menyen «Option» (Alternativ).

Alternativparametere og funksjon
Parameter Beskrivelse Funksjon Merknader

Heat Block 
(Varme-
blokk)

Velg en 
temperaturmodul 
for å slå den på/av

Aktivere eller 
deaktivere spesifiserte 
varmeblokker under 
drift

Dette alternativet 
deaktiveres automatisk 
for andre brønner 
enn første eller siste 
posisjon i den valgte 
patronkonfigurasjonen.

Heat Setup 
(Varme-
oppsett)

Oppvarming når 
trinnet starter

Varmeblokken 
begynner oppvarming 
på angitt trinn

Tiden forbundet med  
varmetrinnet begynner 
når trinnet starter og  
slutter når tiden er ute.

Forvarming: tiden 
starter ved innstilt 
temperatur

Kjøringen starter ikke 
før varmeblokken når 
innstilt temperatur før 
starttrinnet

Tiden forbundet med  
varmetrinnet begynner 
når innstilt temperatur 
nås.

Start når X °C 
under innstilt 
temperatur

Trinnet begynner når 
varmeblokken når 
X °C under innstilt 
temperatur

Varmeblokken varmer opp 
ved lavere temperatur før 
innstilt temperatur

Start oppvarming X 
trinn på forhånd

Varmeblokken 
begynner oppvarming 
opptil 3 trinn før 
gjeldende trinn

Fungerer kun for siste 
brønnposisjon.

Cool Setup 
(Kjøleopp-
sett)

Avkjøling når 
trinnet starter

Varmeblokken 
begynner avkjøling på 
angitt trinn

Tiden forbundet med 
kjøletrinnet begynner når 
trinnet starter og slutter 
når tiden er ute.

Forhåndskjøling: 
tiden starter ved 
innstilt temperatur

Kjøringen settes 
kort på pause når 
varmeblokken når 
innstilt temperatur før 
starttrinnet

Tiden forbundet med 
kjøletrinnet begynner når 
innstilt temperatur nås.

Start avkjøling når 
X °C er over innstilt 
temperatur

Varmeblokken 
begynner avkjøling ved 
innstilt temperatur

Varmeblokken avkjøler 
ved høyere temperatur før 
innstilt temperatur.

Viftealternativ Slå viften av eller på 
under kjøleprosessen

Viften kan være av eller 
på under avkjøling av 
varmeblokken eller 
prøven.

Kapittel 5 Drift
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Magnet 
Setup 
(Magne-
toppsett)

Magnetisering 
starter når 
magnetstengene 
er i posisjon.

Magnetstengene 
flytter seg til innstilt 
posisjon og holder 
seg der under 
oppsamlingsprosessen

Dette alternativet 
er avhengig av 
trinnparameteren Mag 
pos (Magnetposisjon).

Resiproker 
magnetstenger

Magnetstengene 
beveger seg 
opp/ned under 
oppsamlingsprosessen

Dette alternativet 
er avhengig av 
trinnparameteren Mag 
pos (Magnetposisjon).

Trinnmagnetisering
Magnetstengene 
samler opp partikler 
som trinn, avhengig av 
utpekte deler

Partiklene samles opp 
med forskjellige intervaller 
i væsken.

Dry Setup 
(Tørkeopp-
sett)

Over 
reagensstrimmel

Spisskammen heves 
ut av brønnene i 
reagenspatronen

Tørking skjer utenfor eller 
over reagenspatronen.

Over væskenivået 
X mm

Angi hvor langt 
spisskammen skal 
heves over væskenivået

Tørking skjer i brønnen, 
over væskenivået.

Viftealternativ Slå viften av eller på 
under tørkeprosessen

Viften kan være av eller 
på mens de magnetiske 
partiklene tørkes.

Slik legger du til et trinn:

Velg «Insert» (Sett inn) for å legge til et trinn over det uthevede 
trinnet. 

Slik sletter du et trinn:

Velg «Delete» (Slett) for å vise meldingen angående sletting av det 
uthevede trinnet. Velg «Confirm» (Bekreft) for å slette trinnet og gå 
tilbake til skjermbildet. Velg «Cancel» (Avbryt) for å beholde trinnet 
og gå tilbake til skjermbildet.

Slik lagrer du et program:

Velg «Save» (Lagre) for å vise meldingen angående lagring av 
eventuelle nye endringer i protokollen. Velg «Confirm» (Bekreft) for å 
godta endringene og lagre protokollen. Velg «Cancel» (Avbryt) for å 
gå tilbake til skjermbildet uten å lagre endringer.

Kapittel 5 Drift
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Slik navigerer du til forrige skjermbilde: 

Velg «Back» (Tilbake) for å vise meldingen angående lagring av 
nye endringer hvis de ikke er lagret ennå. Velg «Confirm» (Bekreft) 
for å lagre endringene og gå tilbake til skjermbildet Manage Prog. 
(Administrer program). Velg «Cancel» (Avbryt) for å gå tilbake til 
Manage Prog. (Administrer program) uten å lagre endringer.

5.3.3   Redigere en eksisterende protokoll

I startskjermbildet for Manage Prog. (Administrer program) uthever 
du ønsket protokoll og velger «Edit» (Rediger) på høyre side av 
panelet. På det neste skjermbildet uthever du trinnet som skal 
redigeres. Dette tar deg til samme skjermbilde som nevnt i 5.3.2 
Opprette en ny protokoll. Se avsnitt 5.3.2 for mer informasjon.

5.3.4   Programadministrasjon 

Velg «Save As» (Lagre som) på den uthevede protokollen for å 
opprette et nytt navn for den gjeldende protokollen ved bruk av de 
samme trinnparametrene. En melding vil be brukeren om å opprette 
et nytt navn.

Velg «New - 5mL» (Ny - 5 ml) eller «New - 10mL» (Ny - 10 ml) for å 
opprette en ny protokoll i henhold til reagenspatronens størrelse.  
Se avsnitt 5.3.2 for mer informasjon.

Velg «Edit» (Rediger) på den uthevede protokollen for å foreta  
nye endringer i trinn og/eller parametere innenfor protokollen.  
Se avsnitt 5.3.3 for mer informasjon.

Velg «Delete» (Slett) på den uthevede protokollen for å vise 
meldingen angående sletting. Velg «Confirm» (Bekreft) for å slette 
protokollen. Velg «Cancel» (Avbryt) for å avbryte og gå tilbake til 
skjermbildet.
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5.4.1   Instrument 

Instrumentparametere angis under delen «Instrument». 
Etter at du har valgt «Instrument», blir du bedt om å angi 
administratorpassordet. Tilgang til «Instrument»-innstillinger er 
begrenset av leverandøren og blir aktuelt dersom instrumentet 
har sviktet en kjøring eller må repareres. Kontakt Omega Bio-tek på 
info@omegabiotek.com for mer informasjon.

5.4	 Systeminnstillinger

Velg «Settings» (Innstillinger) øverst for å åpne menyen System 
Setting (Systeminnstilling) .

Kapittel 5 Drift
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5.4.2   Dato og klokkeslett
 

Velg «Date & Time» (Dato og klokkeslett) for å stille inn instrumentets 
dato og klokkeslett. Innstillingen kan justeres ved å bruke «+» eller 
«–» på berøringsskjermen eller ved å endre tallene direkte.

5.4.3   Språk
 

Velg «Language» (Språk) for å stille inn språket på instrumentet.
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5.4.4   Avtrekk
 

Velg «Air Ejector Fan» (Avtrekksvifte) for å justere vifteinnstillingen.

Kapittel 5 Drift

5.4.5   Importere og eksportere

Velg «Im. & Export» (Importere og eksportere) for å overføre data 
til og fra instrumentet. Minnepinnen som følger med instrumentet, 
inneholder en mappe kalt «Items» (Artikler) som er beregnet på 
overføring av data. Sett minnepinnen i USB-porten og velg enten 
«Import» (Import) eller «Export» (Eksport) på menyen for å overføre 
data.
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5.4.6   Programvareoppdatering

Ta kontakt med Omega Bio-tek på info@omegabiotek.com for 
oppdateringer.

5.5	 UV-dekontaminering

Velg «UV Sterilizer» (UV-sterilisator) øverst for å stille inn instrumentets 
steriliseringstid. Innstillingen kan justeres ved å bruke «+» eller «–» på 
berøringsskjermen eller ved å endre tallene direkte.

Velg «Start» for å starte dekontamineringen. Velg «Stop» (Stopp) for å 
avslutte dekontamineringen.

Kapittel 5 Drift
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Hvis luken åpnes under dekontaminering, slukkes UV-lyset 
automatisk. Lukk luken for å gjenoppta dekontaminering.

Viktig: UV-behandling skal ikke erstatte rengjøringsprosessen. 
Det er ikke sikkert at kun å legge på UV-behandling sikrer grundig 
dekontaminering. Se avsnittet «Forebyggende vedlikehold» for mer 
informasjon.

5.6	 Hjelp

Velg «Help» (Hjelp) øverst for mer informasjon om de relevante 
funksjonene og instrumentversjonen. Brukeren kan velge hvilken 
innstilling som skal vises, på venstre side av menyen.

5.7	 Avslutte programmet / slå av instrumentet

På baksiden av instrumentet slår du av strømbryteren for å avslutte 
programvaren og slå av instrumentet.
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Kapittel 6 Feilsøking

Bruk denne veiledningen til å feilsøke problemer som kan oppstå.

Problem Mulig årsak Løsning

Displayskjermen fungerer 
ikke som den skal når 
instrumentet er på

Strøm er ikke tilkoblet Kontroller at 
strømledningen er i uttaket.

Bryterfeil Skift ut bryteren. Kontakt 
Omega Bio-tek.

Sikringsfeil Skift ut sikringen (5 x 20, 
250 V, 8 A).

Andre problemer Kontakt Omega Bio-tek.

Ikke noe UV-lys Svikt i UV-lampen Skift ut lampen. Kontakt 
Omega Bio-tek.

Ikke noe lys Svikt i lampen Skift ut lampen. Kontakt 
Omega Bio-tek.

Instrumentet stopper ikke 
når luken er åpen Sensorfeil Kontakt Omega Bio-tek.

Forskjellen mellom 
faktisk temperatur og vist 
temperatur er større enn 
forventet

Sensorfeil Kontakt Omega Bio-tek.

Varmeblokken varmer ikke 
skikkelig

Sensorfeil

Kontakt Omega Bio-tek.SCR-feil

Svikt i varmeblokken

Instrumentet starter ikke 
som det skal

Svikt i kontroller
Kontakt Omega Bio-tek.

Svikt i motor

Unormal lyd under drift

Føringsskinnen er feil 
installert

Kontakt Omega Bio-tek.Svikt i motor

Slitasje på registerreim

Knapp fungerer ikke som 
den skal Svikt i knappen Kontakt Omega Bio-tek.
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Problemtype Problemnavn Feilmelding

Temperatur  
(kode: 0)

T1, T2, T3, T4 
overoppheting E011, E021, E031, E041

T1, T2, T3, T4 
feil på drivkrets E018, E028, E038, E048

T1, T2, T3, T4 
åpen krets E015, E025, E035, E045

T1, T2, T3, T4 
kortslutning E016, E026, E036, E046

Feil på avtrekksviftens drivkrets E019

Feil på kjøleviftens drivkrets E009

Elektrisk maskineri 
(kode: 1)

Bremselåsfeil på elektrisk 
maskineri E108

Elektrisk maskineri,  
slagposisjon  

(kode: 4)

Problem med venstre sensor E403

Magnetstangdeksel på elektrisk 
maskineri, posisjonsfeil E425

Magnetstang på elektrisk 
maskineri, posisjonsfeil E415

LCD, krystalloscillator, 
oppbevaring  

(kode: 7)

Feil på klokkekrystall E702

E2P-feil på lagringsbrikke, 
parameterinnstilling tapt E703

Kommunikasjon  
(kode: 8) Online-feil E801

Kapittel 6 Feilsøking
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Kapittel 7 Forkortelser og symboler

7.1	 Forkortelser

Forkortelse Definisjon

A Ampere

AC Vekselstrøm

V Spenning

Hz Hertz

W Watt

USB Universell seriebuss

Wi-Fi WLAN

kg Kilogram

mm Millimeter

μl Mikroliter

hPa Hektopascal

°C Grader celsius

CV Variasjonskoeffisient for brønnen

TAB (Tabulator) Veksle valg

RUN (Kjør) Start drift

STOP (Stopp) Stopp drift

Kapittel 7 Forkortelser og symboler
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7.2	 Symboler

Symbol Beskrivelse

Forsiktig

Varm overflate

Biologisk fare

Magnetfelt

Ultrafiolett stråling

Strøminngang

Produsent

Produksjonsdato

Autorisert representant i EU

Autorisert representant for Sveits

Se bruksanvisningen eller se den elektro-
niske bruksanvisningen

Regulatorisk merke

Katalognummer
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Serienummer

In vitro-diagnostisk medisinsk utstyr

Unik utstyrsidentifikator

RoHS-samsvar

WEEE-symbol. Produktet skal sendes 
til et separat innsamlingsanlegg for 
gjenvinning og resirkulering

Nettsted

Telefon

Faks

E-post

LinkedIn

Twitter

Facebook

Kapittel 7 Forkortelser og symboler
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Kontaktinformasjon

Hvis du vil etterbestille utstyr, rapportere en feil eller klage på enheten,  
kontakter du:

Produsent
Omega Bio-tek, Inc.
400 Pinnacle Way
Suite #450
Norcross, GA 30071, USA
Nettsted: www.omegabiotek.com
E-post: info@omegabiotek.com
SRN: US-MF-000024148

Autorisert europeisk representant
Qarad EF-REP BV
Pas 257
2440 Geel, Belgia
SRN: BE-AR-000000040

Autorisert representant for Sveits
Qarad Suisse S.A.
World Trade Center
Avenue Gratta-Paille 2
1018 Lausanne
Sveits
CHRN: CHRN-AR-20002058

Storbritannia

Autorisert representant i Storbritannia
Qarad UK Ltd
8 Northumberland Ave
Westminster, London WC2N 5BY
Storbritannia

Kontaktinformasjon
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Bestillingsinformasjon

1.	 Forbruksartikler og tilbehør

Følgende forbruksartikler og tilbehør skal brukes med MagBinder® Fit24-instrumentet 
og kan kjøpes separat:

Komponent Delenr.

MB Fit24™ reagenspatron, 5 ml (200-pakning) PB07-5-200

MB Fit24™ reagenspatron, 10 ml (200-pakning) PB05-10-200

Elueringsrør (200-pakning) PB01-2-200

MB Fit24™ spisskammer (72-pakning) PB12-0-72

MagBinder® Fit24-kvalifikasjonssett B1010-5-00

Besøk nettstedet på www.omegabiotek.com eller ring gratis på  
1-800-832-8896 for mer informasjon.

Bestillingsinformasjon
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Revisjonshistorikk

Revisjon Beskrivelse

v1.0, oktober 2023 Første utgivelse

v1.1, desember 2023 Oppdatert bestillingsinformasjon.
Oppdatert kap. 1.2 Produksjonsgaranti.
Oppdatert kap. 5.2 avsnittet Parametere 

og funksjon.

Revisjonshistorikk
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Spinnsøyler 96-brønners
silikaplater

Magnetiske 
perler

Blod/plasma Plasmid Dyrkede celler Plante og jord

AvføringNGS-rensing Vev FFPE


